# Transforming a Course for Online Learning

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Difference between Face-to-Face and Online Courses</td>
<td>3</td>
</tr>
<tr>
<td>Adding, Renaming, and Deleting Menu Items</td>
<td>5</td>
</tr>
<tr>
<td>Steps for Adding a Button</td>
<td>6</td>
</tr>
<tr>
<td>Steps for renaming a link</td>
<td>6</td>
</tr>
<tr>
<td>To Reorder Links on the Course menu</td>
<td>6</td>
</tr>
<tr>
<td>Translating Face-to-Face into Online Content</td>
<td>7</td>
</tr>
<tr>
<td>Organizing Content: Folders</td>
<td>7</td>
</tr>
<tr>
<td>Course Organization: Chunking into Lessons</td>
<td>8</td>
</tr>
<tr>
<td>What’s in a Chunk?</td>
<td>9</td>
</tr>
<tr>
<td>Translating Face-to-Face into Online Courses</td>
<td>10</td>
</tr>
<tr>
<td>Creating an Announcement</td>
<td>11</td>
</tr>
<tr>
<td>Sending a Blackboard Email</td>
<td>12</td>
</tr>
<tr>
<td>Activity: Creating an Assignment</td>
<td>12</td>
</tr>
<tr>
<td>Submission Details:</td>
<td>13</td>
</tr>
<tr>
<td>Grading and Returning an Assignment</td>
<td>14</td>
</tr>
<tr>
<td>Grading a Single Student’s Assignment</td>
<td>14</td>
</tr>
<tr>
<td>Downloading and Grading All Students’ Assignments</td>
<td>16</td>
</tr>
<tr>
<td>Assignment Submission Problems, and Cleaning Up Files</td>
<td>16</td>
</tr>
<tr>
<td>Clearing an Individual Student Attempt</td>
<td>16</td>
</tr>
<tr>
<td>Inline Grading with Annotations for Assignments</td>
<td>16</td>
</tr>
<tr>
<td>Inline Assignment Grading and New Box View</td>
<td>17</td>
</tr>
<tr>
<td>How to Access Submitted Assignments from the Grade Center</td>
<td>17</td>
</tr>
<tr>
<td>About the Grade Assignment Page</td>
<td>18</td>
</tr>
<tr>
<td>Annotations in Box View</td>
<td>18</td>
</tr>
<tr>
<td>How to Use the Annotation Tools</td>
<td>19</td>
</tr>
<tr>
<td>Drawing Tool</td>
<td>19</td>
</tr>
<tr>
<td>Comment Tool</td>
<td>19</td>
</tr>
<tr>
<td>Inline Grading Panel</td>
<td>20</td>
</tr>
<tr>
<td>Supported Formats</td>
<td>21</td>
</tr>
<tr>
<td>Instructors - Viewing Reports Submitted by Students</td>
<td>22</td>
</tr>
<tr>
<td>Rosters and Managing Users in Blackboard Courses</td>
<td>23</td>
</tr>
<tr>
<td>The Enrollment Process</td>
<td>23</td>
</tr>
<tr>
<td>Making your Blackboard Course Available</td>
<td>24</td>
</tr>
<tr>
<td>Using Groups as a Collaboration Tool</td>
<td>24</td>
</tr>
<tr>
<td>Accessing Groups (Instructors)</td>
<td>24</td>
</tr>
<tr>
<td>Accessing Groups (Students)</td>
<td>25</td>
</tr>
<tr>
<td>Creating Groups in Blackboard</td>
<td>25</td>
</tr>
</tbody>
</table>
The Difference between Face-to-Face and Online Courses

Distance learning courses are likely to fail if they are delivered as if they were traditional courses. If you already use Blackboard for your courses, it probably looks something like the image on the left below. This is our basic template for a face-to-face Blackboard course. It is basically a place to put things; a ‘content dump’ some have called it, but the content doesn’t teach by itself. If we were to translate the basic Blackboard course into our physical classrooms, it would be the equivalent of walking into your classroom, dumping textbooks and articles on a table, then leaving. For a distance education course, we need all the myriad things we do in and out of the classroom to be included – the instructor presence as a Socratic guide through the key concepts and principles, the small group activities, the encouraging, the over-the-shoulder check-in, etc. - you name it. On the right is the basic template for an online course. Notice the difference between the two.
The Course Menu for an online course is organized, has a starting point, includes support links; all activity tools under one button; and all course lessons are carefully sequenced and in chronological order. The menu above has been redesigned for online learning. Here are instructions on how to customize your menu so that it is better for fully online learning.


**Adding, Renaming, and Deleting Menu Items**

To add or edit buttons in the main Course Menu:

1. Click the “+” icon in the upper left of the Course Menu.
2. Choose the type of menu item needed.
3. Name the button, make it available to users and click Submit.

### Button Choices

- **Content Area** is a place to upload files or create content, such as Course Documents or Course Information.
- **Module Pages** are customizable “alert” areas that allow students to see grades, alerts, and tasks in a dashboard layout.
- **Blank Pages** adds a single page of content as a clickable link in your Course Menu. Only text, images and files can be added to Blank Pages.
- **Tool Link** links to tools, including class blogs, wikis, etc.
- **Web Link** pages make it easy to add links to Internet Web sites.
- **Course Link** creates a link to a specific area in your course. If you post your syllabus under “Course Information,” you can link to it from your Course Menu by adding a Course Link.
- **Subheaders and Dividers** allow you to add headings & divider lines.

1. Click on the plus icon and select divider (last option in list). The divider will appear at the bottom of your course menu.
2. Left click the up/down arrows that appear to the left of the divider and drag it up the course menu until it is just below the Announcements button.
3. Add a Content Area (hidden under Add Menu Item in picture above) and label it *Start Here*.
4. Move this new button up until it is just above the divider.
5. Add a second content area and name it *Modules*.
6. Move this new button up until it is just below the *Course Information* button.
7. Remove the button called *Course Documents* – we will use Modules instead.
8. Finally, add another divider and move it up until it is right above the Assignments button.
Steps for Adding a Button

1. Click the “+” icon upper left, choose your content area.
2. Fill in the name of the link.
3. Check available to users.
4. Click Submit.

Steps for renaming a link

1. Hover over the link in the menu bar, click the down arrow, then click Rename Link.
2. Rename the link then press enter or the green check mark.

To Reorder Links on the Course menu

1. Hover over the link, a four-way arrow will appear, click and hold on it and drag it up or down and release the mouse button.
### Translating Face-to-Face into Online Content

<table>
<thead>
<tr>
<th>Face-to-F Elements</th>
<th>What they might look like online…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation of facts/concepts/Principles</td>
<td>Videos, readings, podcasts, recorded ‘lecturettes’ and other multi-media created by you or found online.</td>
</tr>
<tr>
<td>Discussion</td>
<td>Discussion Board</td>
</tr>
<tr>
<td>Practice</td>
<td>Publisher’s digital exercises like flashcards, low stakes quizzes, problem sets, writing assignments, case studies</td>
</tr>
<tr>
<td>Reflection</td>
<td>Journals, short essays</td>
</tr>
<tr>
<td>Demonstrate Proficiency</td>
<td>Application (go do it!), written assignments, tests, problem sets, case studies, projects, Discussion Board</td>
</tr>
<tr>
<td>Group Work</td>
<td>Blackboard groups, web conferencing, wikis</td>
</tr>
</tbody>
</table>

### Organizing Content: Folders

We taught you about learning modules, but you will notice in some of the exemplary courses that instructors used folders. It doesn’t really matter whether you choose to use folders versus using learning modules; it is the principle that is important. We need organized, consistent content that is easy to follow. You don’t want your students to spend all their time trying to find things. You want to avoid a ‘content dump’. Whether you use folders or modules, you will need to include lots and lots of text throughout – instructions, helpful tips, and key learning take-aways. Don’t just plunk the materials into the course without an introduction for each piece. This helps them to ‘hear’ you as they are going through the materials and close some of that distance.

To create a folder in Blackboard:

1. Go to any content area of your course (such as Assignments).
2. Click the **Build Content** button ➔ Click **Content Folder**.
3. In the **Create Content Folder** window, enter a Name for the folder, and optionally a description under text.
4. Make sure users can view the content and set other options as needed.
5. When done, click **Submit**.
6. After creating the folder, you can add content. Simply click on the folder title, then add files, images, assignments as you normally do.
Now that we have our objectives, we need to organize them into lessons.

People can’t easily recall and retrieve large amounts of ideas/facts/concepts. So, we break up our learning into smaller chunks. A student should be able to get through a chunk in about 20 minutes.

Start with large chunks of conceptually related content, and then divide these into smaller related chunks. Continue with this process until content is broken down into chunks that contain 5-9 or so ideas/facts/concepts, less if the content is more complex.

One recommendation for a face-to-face class is 7 chunks per lecture period (University of Southern Florida COPH ETA, 2011). For an online course, it depends on who you ask, and also depends on the complexity of the chunk. Our working memory doesn’t hold all that much, so chunks are better for learning. Chunking is also a better fit for online students who are likely juggling family, work, and classes. They are very easily distracted, so chunking helps keep them focused (University of Southern Florida COPH ETA, 2011) and fits into their busy schedules. It might help if you think of it in terms of how a text book is written. Typically, text books have chapters, and then the chapters are broken down into units and lessons. We are doing the same.
thing, but in an online course. We’re trying to figure out a logical progression for our modules, lessons, and topics (Malamed, 2009).

We recommend that you develop chunks that a student can get through in say 20-25 minutes. Then, scale up. 3 chunks = lesson, 3 lessons = unit. Each module should segue one to the other, and be interrelated in some form. Since your course template is set up by weeks, you will need to figure out what to include in each week.

“Each lesson should (Netnet, 2002):
• Immediately capture the student’s attention
• Explain its own relevance by answering the student’s question, "What's in it for me?"
• Present specific and measurable learning objectives
• Present engaging content through design and media
• Offer the student an opportunity for practice and recall
• Include a final post-test or other device to indicate mastery “

What’s in a Chunk?

Use whatever works for you. Here are two examples of simple chunking organizers. These organizers can help you to plan your weekly content in your online course.

<table>
<thead>
<tr>
<th>Learning Objective</th>
<th>Instructional Activity</th>
<th>Assessment Activity</th>
<th>Resources Required</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Learning Objective</th>
<th>Introduction</th>
<th>Presentation of Content</th>
<th>Interactivity</th>
<th>Practice</th>
<th>Demonstration of Proficiency</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

First, map out what you plan to do. Here’s a quick overview of an online lesson. It includes an Introduction, practice/application, and then demonstration that they mastered it. This is the sequence we apply to our chunks and using this consistently throughout the course will help the online learner.

Try whenever possible to build in some form of interaction…this closes up the distance for learners and helps them build a sense of group, rather than feeling isolated. It also allows learners to share their own expertise with the class. Adult learners like interaction and they want to share.
For each Learning Objective provide:

- Introduction
- Presentation of concepts and other content
- Activity/Interactivity/Practice
- Demonstration of Proficiency

## Translating Face-to-Face into Online Courses

But how do I? First time online instructors often struggle with translating their face-to-face activities into online ones. Here’s a chart that shows some basic activities and how you do them in an online course.

<table>
<thead>
<tr>
<th>How you do this face-to-face</th>
<th>How we do this online</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation of facts/concepts/principles</td>
<td>YouTube or other premade videos, readings, podcasts, recording “lecturette”</td>
</tr>
<tr>
<td>Discussion</td>
<td>Discussion Board</td>
</tr>
<tr>
<td>Quizzes</td>
<td>Quizzes (but not many)</td>
</tr>
<tr>
<td>Practice</td>
<td>Publisher’s digital exercises like flashcards</td>
</tr>
<tr>
<td>Reflection</td>
<td>Journals, written short essays</td>
</tr>
<tr>
<td>Group work</td>
<td>Collaborative tools like Blackboard groups, web conferencing, wikis</td>
</tr>
</tbody>
</table>

They are very similar, but you may have to learn some new Blackboard tools. The main difference is that your lesson-size is much, much smaller, is more interactive (less lecture) and the discussion board is typically used to assess learning, rather than testing (because you can’t proctor an online test easily).
Creating an Announcement

Go into your course and create an announcement, sending it to students.

Click the **Announcements** link on the main Course Menu.

1. Click the **Create Announcement** button.

2. Add any information, text, videos, graphics, photos you like just as you would in any other content area in Blackboard.

3. In section 2, **Web Announcement Options**, set Announcement to **Not Date Restricted**, otherwise, your announcement will not appear to students until the date you set below under **Date Restricted**.

4. You can also Email your students a copy of the Announcement by checking **Send a copy of this announcement immediately**. Please note, that when you send messages through Blackboard’s email system, it will send it in a text (not HTML) format, so you will not see images in the body of your message.

   NOTE: Your email is sent **immediately** to students; however if you date restrict it, a pop-up warning will appear saying you cannot send an announcement via email for a future date.
5. When done with your announcement, click **Submit**.

### Sending a Blackboard Email

Blackboard has a built-in Email tool available to course users within each course. There are two ways to access it. Go into your practice course and send a test email to the sample students in your course.

A. On the Course Menu → **Tools** → **Send Email**
B. On the Course Menu → **Course Management** section → **Course Tools** → **Send Email**
C. Choose who to send it to, typically All Users.
D. Compose Email text.
E. Click **Submit**.

### Activity: Creating an Assignment

Assignments are one of the critical ways to assess students and evaluate their meeting of the course and/or lesson learning objectives. Go into your **Practice Course** and create an assignment.

1. Open up a Content Area (e.g. “Course Documents” or “Assignments”).
2. From the **Assessments menu**, select **Assignment**. The Assignment Tool opens.
3. Type a name for the assignment.
4. Enter very clear instructions for the students on how to complete and submit it.
5. Optional: Use the Browse button to upload long assignments as attached file (e.g., Word document, Excel file, etc.).
6. Optional: Set a Due Date. Items submitted after the Due Date will be marked late in the grade center.
7. Designate a point value (for grading), and add a rubric if desired.
8. Several changes were made to the Create Assignment page in Blackboard under the Grading section. Previously, these blocks were openly displayed, but now they are collapsed. Click on each link to expand the block.

**Submission Details:**

SafeAssign is integrated into regular Blackboard Learn Assignments under this section.

a. Choose whether the assignment is an **Individual** or a **Group Submission**.

b. Instructors can select the **Number of Attempts** allowed (Single, Multiple, Unlimited).

c. The following Plagiarism Tools are now available:
   - Check submissions for plagiarism under SafeAssign
   - Allow students to view SafeAssign originality report for their attempts
   - Exclude submissions from the Institutional and Global References Databases

---

**Setting Submission Details in the Assignment Tool**

a. Leave the defaults under Grading Options.
b. Choose how you want your grades displayed (Score, Letter, Text, Percentage, Complete/Incomplete).
c. Choose whether or not to Include in Grade Center grading calculations.
d. Select whether or not you want to Show to students in My Grades.
e. Elect whether or not to Show Statistics.
Grading and Returning an Assignment

When you create an assignment using the Assignment Tool, a column is automatically created for it in the Grade Center. Instructors access students’ submitted assignments through the Grade Center and have the option of accessing individual assignments for grading, or of downloading all assignments and then grading them.

Submitted assignments will appear in the Grade Center as a green exclamation point. If the student has only saved it, but not used the Submit button, you will see a notebook icon instead.

1. Enter the Grade Center from the Control Panel.
2. For each student who has an assignment that needs grading, you will see a green exclamation mark icon. Click on the chevron icon next to it and select View Grade Details to access a student’s assignment.
3. Click View Attempts to open up the assignment and access the student’s submitted file. The Inline Grading panel will open up with the currently selected student’s name at the top.
4. If the student submitted a file, Blackboard will load the paper in the preview panel where you can annotate and mark up the document. In the Assignment Details panel on the right, enter the Grade and Feedback to Learner.
5. **SafeAssign Submission** – This option only comes up if you as the Instructor have elected to have students submit their work via SafeAssign for plagiarism.
   
   a. The inline grading block to the right will indicate how much of an *overall* match the assignment is.
   
   b. Click the down arrow next to **SafeAssign** to expand the block and then click **View Originality Report**.

   ![Image of SafeAssign Originality Report]

   c. A new window will take you out of Blackboard to SafeAssign’s page where it will let you see where students stand on their plagiarism and their sources.

6. Alternatively, instructors can click the link for the file under **Submission** on the Assignment Details panel on the right to download the file to your computer to grade the paper offline.

7. **NOTE:** If there was a problem with the submission, go back to the Grade Center, View Grade Details and use **Clear Attempt**. Clearing the attempt allows student to complete the assignment again, but removes all trace of partially completed work!

8. Locate the file on your computer and grade it. Afterwards, return to the Blackboard Grade Center and click **View Grade Details**.

9. Click on **View Attempt** again.

10. Under Assignment Details, insert a grade and comments for the student. If you are returning the student’s assignment with markups, click the paperclip icon in the Feedback to Learner box, Browse to upload the file.

11. **Add Notes** – This used to be formerly Instructor Notes. Use this to add private notes and/or attach a file if needed. Students cannot see these notes or files!

12. Click **Submit**. You are returned to the Grade Details window. Check to be sure that the student’s grade has been entered. Click **Return to Grade Center** and verify that the grade is in the column.
**Downloading and Grading All Students’ Assignments**

- In the Grade Center, click on the assignment column heading, and then select **Assignment File Download**.
- Click on the column headings to sort the students into categories (e.g. “needs grading”).
- Use the checkboxes to select which students’ assignments you would like to download. To select all students, click on the checkbox next to the word “Name.”

![Selecting a Download Option](image)

- After selecting, click **Submit** at the top or bottom of the page.
- Click on the link name to download the zipped file to your computer (MAC users should press `control` and `click`). You can now unzip it to review and grade students’ work.

**Assignment Submission Problems, and Cleaning Up Files**

If an error has occurred during submission, you may have to clear the attempt and have the student resubmit the file.

**Clearing an Individual Student Attempt**

1. Go to **Control Panel → Grade Center**.
2. Click in the Grade Center cell for that assignment next to the student in question.
3. Click on the chevron icon and select **View Grade Details** to access a student’s assignment.
4. Select **View Attempt** to see the assignment (this may not be possible).
5. Select **Clear Attempt** to remove the assignment so the student can try again.
6. Confirm your selection by clicking **OK**.
7. You will receive confirmation that the assignment was cleared. Click **OK**.
8. You will be returned to Grade Center. Click **OK**.

**Inline Grading with Annotations for Assignments**

Excerpted from: [http://help.blackboard.com](http://help.blackboard.com)

When you create an assignment, a column is added automatically to the Grade Center. An assignment that has been submitted, but not graded, is indicated with an exclamation mark—the needs grading icon.
You can access assignments that have been submitted by students and need grading from the:

- Needs Grading page -OR- Full Grade Center

Depending on your grading style, you can access and grade one assignment attempt, view all the submissions for one assignment, or view all the assignments with submissions that need grading. Inline Grading means you can open a submitted assignment, mark it up, add comments, and annotate the document – all within Blackboard. You no longer have to download the document and open it in Microsoft Word to mark it up.

**Inline Assignment Grading and New Box View**

The Blackboard Assignment tool has an online document viewer and annotation feature that uses a third party technology licensed by Blackboard known as Box View.

Student file submissions are stored in University of Hartford’s Blackboard Learn instance as always. No personally identifiable data about students is sent to Box. Blackboard Learn retrieves a document ID from Box and assigns it to the document. That mapping of Document ID to user, course, assignment, and attempt is tracked locally in Learn. None of that data is available to Box. All that is transmitted to Box is the file for conversion. The converted file is stored in the Box service, as are any annotations made on the converted file.

The New Box view offers a few improvements over Crocodoc, including improved rendering and expanded support of new file types. The New Box view provides a simple and convenient way to annotate student submissions. Prior student work that had been graded and annotated within Crocodoc has been migrated to the New Box view and instructors and students will be able to continue to view those documents.

**How to Access Submitted Assignments from the Grade Center**

The Grade Center shows all gradable items. The number of items may influence how you organize your time for grading tasks. You may also find it beneficial to view a student's previous grades as you grade.

**To grade a single assignment attempt:**

1. Go to the Grade Center.
2. Locate the cell for a student's assignment containing an exclamation mark.
3. Access the cell's contextual menu and select Attempt.
4. The Grade Assignment page appears.
To grade all submissions for an assignment:

1. Access the assignment column's contextual menu.
2. Select Grade Attempts.
3. The Grade Assignment page appears.

**About the Grade Assignment Page**

You access the Grade Assignment page from the Needs Grading page or the Full Grade Center. You can navigate among users and attempts, view rubrics, grade anonymously, and view information about an assignment.

Assignment submissions created with the content editor are not compatible with inline grading. Submissions of this type show in the window, but annotation is not available.

### Annotations in Box View

Reviewing and Grading Tools

A. Draw directly on the document
B. Review and comment directly in the document.
C. Input the grade. Grade the submission from the inline grading sidebar. From here you can view the assignment details, the grading rubric and each attempt.
D. Give feedback to learner. You can type an overall grade and grades for each attempt as well as provide feedback to your students without leaving the page.
E. Download the document.
F. On the action bar, you can:
   - Click Hide User Names to grade attempts anonymously. Click Show User Names to display user information.
   - Click Jump to and select another attempt to view or grade.
   - Navigate among available attempts.

**How to Use the Annotation Tools**

**Drawing Tool**

Click the Pencil icon in the viewer toolbar, then press down and draw on the document. Click **Done** when finished.

**Comment Tool**

Click on the Comment button in the viewer toolbar, then click anywhere within the document to place the comment. Type your comment into the box, then click submit.
To delete the comment, click on the chat bubble within the document again, then click the trashcan icon to remove it. Then click **Delete**.

**Inline Grading Panel**

The inline grading sidebar gives you all of the tools you need to grade the assignment inline.

A. Expand assignment details to show the information from the assignment content item.
B. Collapse or expand the grading sidebar for more screen real estate.
C. Select additional attempts from a drop-down list. Click the attempt to load the submission in the inline viewer and update the sidebar with the appropriate attempt-related data.
D. Type a grade for the attempt.
E. Download the originally submitted file. If more than one file was submitted for the attempt, all files are available here.
F. Expand the Inline Panel to view the rubric and comments fields.
   - Use the grading rubric associated with the assignment.
   - Add private notes, not visible to the student as feedback.
   - Type feedback the student can see and attach files. You can expand the feedback field to take advantage of the full content editor features.

**Supported Formats**

PDF, PPT, PPTX, DOC, and DOCX are the best formats for students to submit and are also supported by the SafeAssign tool.

New Box View only supports annotations on these file formats: AI, BMP, DCM, EPS, GIF, PNG, PS, PSD, SVS, TGA, TIF, and TIFF.

The converted document is displayed in the New Box viewer on the Grade Assignment page. Formatting and embedded images of the original document are preserved in the conversion.

The viewer is supported on current versions of Firefox, Chrome, Safari, and Internet Explorer. No plug-in or other application is necessary, though some users have reported issues in Safari or Internet Explorer. If you are experiencing issues, try switching browsers.

Users may experience a delay in the processing of their file (usually a few seconds). Depending on their browser, the viewer pane may or may not refresh automatically. If it does not, use your browser’s refresh button to refresh the screen.

If a student has uploaded a file that is not in a format supported by the inline viewer, you are prompted to download the file in question. You will not see the inline viewer.

If you plan to use SafeAssign, please insert an additional statement such as the following:

*The issue of digital plagiarism has raised concerns about ethics, student writing experiences, and academic integrity. Although you may never have engaged in intentional plagiarism, many students do incorporate sources without citations, which is a form of plagiarism. The University of Hartford subscribes to a digital plagiarism detection program called SafeAssign, which you can use to check papers for this course and see whether you may have included in your paper material that requires a citation. Further instructions will be given in class.*
You will upload your work to Blackboard through SafeAssign so that it can be checked against web pages and databases of existing papers. Your paper will then automatically become part of that database for future use.

**Instructors - Viewing Reports Submitted by Students**

Any papers submitted to Safe Assign by students be viewed by the instructor through the Control Panel.

1. Go to: **Course Tools > SafeAssign > Safe Assignments.** You will see a list of all your SafeAssignments.

   ![List of all SafeAssignments in Course](image)

2. Next to the SafeAssignment you wish to view, use the chevron arrow to select **View Submissions.**

3. All papers submitted for the assignment appear in a grid, showing the time and date they were submitted.

4. Click on the green checkmark in the SA Report column to access student reports.

<table>
<thead>
<tr>
<th><strong>Download all Submissions</strong></th>
<th>Saves all submitted assignments in a downloadable zip file.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text</strong></td>
<td>Shows text, authorship and student comments on a paper.</td>
</tr>
<tr>
<td><strong>File</strong></td>
<td>Opens (or Saves) an individual paper for downloading.</td>
</tr>
<tr>
<td><strong>Matching</strong></td>
<td>Shows the percentage of text matched to other sources.</td>
</tr>
<tr>
<td><strong>SA Report</strong></td>
<td>Opens SafeAssign’s report on a paper.</td>
</tr>
<tr>
<td><strong>Submitted</strong></td>
<td>Shows time and date submitted.</td>
</tr>
<tr>
<td><strong>Clear Attempt</strong></td>
<td>Removes paper from the database and allows student to resubmit.</td>
</tr>
</tbody>
</table>
List of Reports for each Student who Submitted the Assignment

The instructor has several options for managing submitted files:

During peak periods, such as mid-terms and finals week, there may be delays in getting reports back from SafeAssign. If you experience delays longer than 24 hours, please contact FCLD.

Student submissions to SafeAssign are compared against several sources:

- Institutional document archives: Contains all papers submitted to SafeAssign by users in their respective institutions.
- Global Reference Database: Contains over 15 million papers volunteered by students from Blackboard client institutions to help prevent cross-institutional plagiarism.
- ProQuest ABI/Inform database: More than 1,100 publication titles and about 2.6 million articles from the 1990s to present time, updated weekly.
- Internet: SafeAssign searches across the broader internet for matching text using the Yahoo! BOSS search service as the underlying internet index provider.

---

Rosters and Managing Users in Blackboard Courses

To view rosters/users in your course, go to your course:

1. On the control panel on the left, look under Course Management.
2. Click the Users and Groups link to expand it.
3. Click on the Users link.

The Enrollment Process
• Students are automatically enrolled in Blackboard courses.
• Enrollment changes in Banner may take 24 hrs. to update in Blackboard.
• If you manually enroll students in your course, you can break the automatic linkages between Banner and Blackboard. Double check your roster in Blackboard against Self-Service. If there are any discrepancies, contact feld@hartford.edu. Include student names and IDs.

### Making your Blackboard Course Available

You’ve got your course set up for the term, but now it’s time to make it available to students to access. Until you make a course available, students who are enrolled cannot see it on their

1. Click into any content area (e.g. Course Documents, Assignments, Course Information, etc.)
2. Click the lock icon in the upper right (between the Student Preview eyeball icon and the Edit Mode) to toggle Availability on or off (red is off).

### Using Groups as a Collaboration Tool

**Accessing Groups (Instructors)**
1. Find Groups in Control Panel under Users/Groups.

2. Click on the arrow to reveal a menu that may be helpful for maintaining and communication with your groups.

**Accessing Groups (Students)**

1. When students are assigned to a group, they can find it in the ‘My Groups’ box directly under the Course Menu. They can click the right-facing arrow to show more details such as their group members, and links to the tools they can use in their group.

Students only see links to groups they have been assigned to as a member and only group members can collaborate and use tools within the group.

Instructors can see/comment/contribute/interact/collaborate within ALL groups.

**Creating Groups in Blackboard**
Blackboard can be used for student group projects and other small group activities. Blackboard groups allow smaller groups of students to meet online privately to share and exchange files, send group emails, participate in discussion boards, collaborate using blogs and wikis, and meet to chat in virtual classrooms. It’s especially useful to be able to create groups if an instructor has multiple sections enrolled in the same Blackboard course, as each section can be set up as a group allowing the instructor a means to communicate with each section individually.

Blackboard now has 3 ways to add students into groups:

- **Self-Enroll** – Students can select which group they want to join.
- **Manual Enroll** – The instructor creates the groups and enrolls students in each group.
- **Random Enroll** – The instructor creates the groups and Blackboard assigns students to the groups randomly.

Creating a group has two parts: first you create the groups, and then you assign students to the group.
To create groups in your course:

- In the Control Panel of your course, click on Users and Groups and then Groups.
- Point to Create Group Set in the Action Bar and select the type of groups you would like to create. (The options available to each group are the same.)
- Give the groups a name such as ‘Final Project Group’. Blackboard will add a number to each group name (e.g. ‘Final Project Group 1’, ‘Final Project Group 2’).
- Make sure Group Available is set to Yes.
- Decide which tools you would like to make available to each group:

**Self-Enroll**

If you are allowing students to choose their own groups, select the Self-Enroll option under Group Set.

Under Group is visible to students, click Sign-Up Sheet Only unless you want them to be able to sign up and then get straight to work without you approval. If ok to sign up and go to click yes.

- Under Sign-up Options, give a name for the sign-up sheet and instructions for signing up.
- Select the maximum number of students that can enroll into each group.
- If you want students to see who else is in a group before signing up, click on Show Members.
- Select the total number of groups you would like to create.
- Click Submit.
- When your students log in to your course, they go to Tools → Groups to see the group signup sheet. From here, they can click on a button to sign up for a group.
Manual Enroll

If you want to choose which students should go in which groups, click the Create Button, and then under Group Set select the Manual Enroll option.

- Enter a name for the groups, then under Group Set Options, select the number of groups you would like to create.

- Click Submit. A new window will open up, allowing you to choose members for each group. Under each Group, click the Add Users button.
- In the Add Users menu, check each of the students you want in that group. When done, click Submit.

- Click on the X next to the student name to remove them from the group

- Use the Add Group and Delete Group buttons to add or remove extra groups if needed.
- When you have assigned students to each group, click Submit at the bottom of the page.
Random Enroll

Blackboard can also assign students into groups automatically. The instructor has the following options:

- **Determine Number of Groups by:** Choose either the number of students you want in each group or the total number of groups you want, and Blackboard will divide the students accordingly.

- **Determine How to Enroll any Remaining Members:** If the groups do not divide out evenly, you can choose to distribute the remaining members amongst the groups, put the remaining members in their own group, or manually add the remaining members to groups.

1. On the control panel under Course Management, go to Users and Groups, then click on Groups.

2. In the Groups window, click the Create button, then click Random Enroll.

3. Give your Group Set a name (here you will select a generic name, ie) Groups – and if there is more than one group, it will automatically number it: Group 1, Group 2, etc. Fill in the description. Set the group visible to students.

4. Choose whether or not to grade the group, and other options.

5. At the very bottom, set your membership settings (Number of Students per group, number of groups, etc.)

6. When done, click Submit.
Accessing Discussion Boards

There are essentially two types of Discussion Boards in Blackboard – the whole-class discussions accessible via the Course Menu and group discussions. Both can be accessed by instructors by going to Course Management → Course Tools → Discussion Board.

Creating a Discussion Forum

To create a forum, go into your course, click the Discussion Board link on the Course Menu, then click the Create Forum button.

1. Access the discussion board and click Create Forum on the action bar.
2. On the Create Forum page, type a name and optional instructions or a description. On the main discussion board page, the description follows the forum name.
3. In the **Forum Availability** section, click **Yes**. Another option is to create forums ahead of time and set the availability to **No** until the discussion is ready to start.

4. Select the **Display After** and **Display Until** check boxes to enable the date and time selections. Display restrictions do not affect the forum availability, only when it appears.

5. Select the **Forum Settings** based on your specific needs.

To promote originality, creativity, and a variety of responses, you can choose **Participants must create a thread to view other threads in this forum**, which is the post first setting. Students must respond before they can read their classmates’ posts.
In Standard View, users can see all previously created threads in the forum.

6. In the Grade and Due Date section, set your options accordingly. Selecting Grade Discussion Forum and inputting a point value also enables the Add Rubric button from which instructors can Select Rubric, Create New Rubric or Create from Existing.

7. Adding the Due Date will not allow students to submit posts after that date.

8. There are several other options to choose from in the Forum Options, select them if you wish to use them.

9. When done, click Submit.

Creating Threads

Threads are questions that students answer or can be used to start new topics. Within each forum, users can create multiple threads. A thread includes the initial post and any replies to it. Instructors have the option of allowing or not allowing students to start threads.

When you view the thread page, all posts and the forum description appear on one page. Forum descriptions are often used as prompts for discussion and are visible where you are posting. Large images of course members help you easily identify authors.

To help make replying easy, a Reply button appears directly below the post you wish to reply to. Clicking the Reply button opens up a text box in which you can type your reply and then click Submit when done.
Forum settings control who can post, and what other types of actions you can take, such as editing your own threads, posting anonymously, or rating posts. Depending on which forum settings your instructor has selected, you may be allowed to create a new thread.

**Replying to a Threaded Discussion**

In this exercise, you will practice replying to a thread that has already been created. Go to the *Preparing to Teach Online* course and go into the *Introductions* Forum and post a reply to the first thread you see there.

1. From the Course Menu, click on Discussion Board.
2. In the Discussion Board window, click the forum link for Introductions.
3. Click on the thread link Intro.
4. Read the introduction prompt and click the Reply button.
5. Append the Subject with your name (ie: Re: Intro – First Last) and type your introduction into the Message field.
6. When done, click Submit.

---

**Blackboard’s Grade Center**

Blackboard’s Grade Center is an online grade book. It helps you calculate running grades, track student progress, provide feedback to students, download grades to your computer – even create reports. You don’t have to type in student names; Blackboard does it for you. All you have to do is add columns. Some columns are created automatically by Blackboard when you use Blackboard features such as Tests, Surveys, Assignments, and any other items you create with a ‘graded’ status. The Grade Center is very flexible, allowing you to drop lowest grades, weight grades, filter views, and more. Students can’t see Grade Center but they can see their own individual grades in a tool called My Grades.

**IMPORTANT:** The Grade Center is complex. It is strongly recommended that you attend a Grade Center seminar. Please contact FCLD to find out when a Grade Center seminar is offered. Call 768-4661 or email fcld@hartford.edu. You may check our seminar schedule here: [https://www.hartford.edu/faculty-staff/faculty/fcld/seminars-workshops/default.aspx](https://www.hartford.edu/faculty-staff/faculty/fcld/seminars-workshops/default.aspx)
Overview

The Grade Center can serve as a communication tool, an evaluation tool, and a timely feedback mechanism. To achieve any of these, the best practice is to add all Grade Center items, grading schema (letter grade settings), weights, and other options before the semester begins. By finalizing your Grade Center early, students who click on their grade center view, My Grades, at the beginning of the semester can see all assignments, tests, graded forums, and other items along with the descriptions, points possible, due dates, etc., giving them a great overview of the course and an extension to your syllabus. Please note that Blackboard Grade Center is not your grade of record, and you must still input your grades into Self-Service using the University’s official 4.0 scale.

Basic Steps (Detailed Steps Follow)

- Design and build your course.
- Delete unnecessary columns such as extra student information and duplicate total/weighted total columns.
- Add columns via deployment of tests, surveys, assignment tools, and discussion board grading, then modify those columns as necessary.
- Add any other columns you’ll need.
- Set up a calculated column, e.g., running weighted total.
- Click the Preview User icon in the upper right to enroll your preview user (test student) into your course.
- When done, click the Exit Preview button and select “Keep the preview user and all data,” then click Continue.
- Enter comments and test scores for you as your test student as if the semester were over.
- Click the Preview User icon again to view the course as a student and click on My Grades from the Tools Menu. Check to make sure grades are reporting properly, descriptions are clear, comments look okay, and that tests and surveys work properly to avoid errors during the semester.

IMPORTANT: You will need to submit your final grades for the semester using Banner, Self-Service Center. Blackboard will not do this automatically. Please call your department if you need help submitting grades.

Viewing and Accessing Grades

Instructors, Teaching Assistants, and Graders are the only roles in Blackboard that can edit and view the full Grade Center. This view includes all assignments, menus, and grades for all students. Students can only view and access their own grades and related information. They are never able to see another student’s grades.
Grade Center columns are added automatically whenever you add tests or Surveys, Assignments, and any graded activity to Blackboard.

Instructors access the Grade Center from the Control Panel, and then select Grade Center → Full Grade Center (see image at left).

NOTE: Students access their grades from within each course via Tools → My Grades. Many instructors add this tool to their course menu. Here’s how:

- Make sure Edit Mode is set to ON.
- Point to the ‘plus sign’ icon on the upper left of the course menu and click Tool Link.
- Type in a name, such as ‘Check Your Grades’.
- Change ‘Type:’ to My Grades.
- Click Available to Users.
- Submit.

Grade Center Basics

Step One: Make the Most of your Space

The grade center is a basically a spreadsheet comprised of columns and rows. Students are automatically listed in the Grade Center, appearing as rows, when they are enrolled into your Blackboard course. Columns are manually added by you or automatically added when you add an item to your course with a graded component (such as an Assignment, Test, Journal, Wiki or Blog).

To conserve space, it is recommended that you hide some of the default columns included in every grade center. These include: Username, Student ID, Last Access, and Availability.

Here’s how to hide student information columns:
• Point to the column heading such as ‘Username’ and click the arrow to reveal the drop-down menu.
• Click Hide Column.

It’s important to hide only student information columns (see them circled above) as opposed to hiding any of your graded columns. Using ‘Hide Column’ for graded columns only hides the columns from you; your students can still see them in their ‘My Grades’ and it may cause confusion.

To further save space and reduce confusion for your students, it would be best to remove the extra ‘final grade’ columns that appear such as **Weighted Total** and **Total**. You may find several of these since they are duplicated by course copying and by the Blackboard system course creation process. These columns help you set up your final grading scenario, so you only need to keep one. Use **Weighted Total** to help you set up grading if you weight grades to arrive at a final grade, and use **Total** to help you set up grading if you add points to arrive at a final grade.

Here’s how to delete extra **Weighted Total** and/or **Total** columns:

• Point to the column heading such as ‘Weighted Total’ and click the arrow to reveal the drop-down menu.
• Click **Delete Column**.

**NOTE:** If you see a green check in the column heading, it will stop you from deleting the column. To continue, move the green check to a column you want to keep. Here’s how:

• Click the arrow in the label of a column you want to keep.
• From the drop down menu, click **Set as External Grade**. Note that students will **ALWAYS** be able to see this column.

The green check will move to that column and allow you to delete the columns you do not want to keep.

**Step Two: Creating Columns in the Grade Center**

You have the option of creating columns either manually or automatically. Automatic columns will appear linked to any item you add to your course that has an automatic grading option (such as Assignment or Test) and those items that you have chosen the option of grading within Blackboard. It’s best to create your course fully, then add any columns manually that have not been already added. **Grade Center columns are added automatically whenever you add tests or Surveys, Assignments, and any graded activity to Blackboard.**
1. To create a column in Grade Center, select **Create Column** (see image below).

![Creating a Column in the Grade Center](image)

2. Fill in the column name and description.
3. Assign it to a category, which is used for weighting grades by category, for example, all items with the category of ‘Test’ are weighted at 20% in final grades.
4. Assign points possible (100 point totals are easiest and recommended).

**Step Three: Checking and/or Editing Grade Center Columns**

To edit or find out information about a column, click the arrow next to a column heading. A drop-down menu opens. Some of the options you may see are as follows:

<table>
<thead>
<tr>
<th><strong>Quick Column Information</strong></th>
<th>Shows information about the column.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Grade Attempts</strong></td>
<td>Shows what students have submitted.</td>
</tr>
<tr>
<td><strong>Grade with User Names Hidden</strong></td>
<td>Allows anonymity while grading.</td>
</tr>
<tr>
<td><strong>Reconcile Grades</strong></td>
<td>Allows you to review grader progress for the current assignment, and provide an official reconciled grade for each attempt (useful when multiple graders).</td>
</tr>
<tr>
<td><strong>Assignment File Download</strong></td>
<td>Allows you to quickly download all submitted documents for that grade column.</td>
</tr>
<tr>
<td><strong>Assignment File Cleanup</strong></td>
<td>Will delete documents associated with any or all students by selecting the users and clicking Delete.</td>
</tr>
<tr>
<td><strong>Rubric Evaluation Report</strong></td>
<td>Displays the average results of evaluations using the selected Rubric for the selected Grade Center column.</td>
</tr>
<tr>
<td><strong>Edit Column Information</strong></td>
<td>Allows you to go back into the column to modify it.</td>
</tr>
<tr>
<td><strong>Column Statistics</strong></td>
<td>Shows statistics for that item, such as grade distribution.</td>
</tr>
<tr>
<td><strong>Set as External Grade</strong></td>
<td>Allows one grade to show outside of Grade Center. This cannot be blocked from student view and cannot be hidden.</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Hide from Students (on/off)</strong></td>
<td>Allows you to show the column to students or hide the column from students.</td>
</tr>
<tr>
<td><strong>Clear Attempts for All Users</strong></td>
<td>Clears any submitted work for that grade column.</td>
</tr>
<tr>
<td><strong>Sort Ascending/ Sort Descending</strong></td>
<td>Sorts the column by grade. Note that when you select this, all other information will be carried with that particular sort. To resort by last name (default view), click on the last name column heading.</td>
</tr>
<tr>
<td><strong>Hide from Instructor View</strong></td>
<td>Hides the column from your view only. Students can still see the item unless you have hidden it using the show/hide to users option.</td>
</tr>
</tbody>
</table>

These options vary slightly when created automatically, reflecting the tool’s capability.

**Step Four: Setting up a Calculated Grade Column**

After you have created your Grade Center columns, you are ready to set up the calculated column. If you don’t have one, select Create Calculated Column > Weighted Column or Total Column. After providing the column name and description, you have the ability to select columns and/or categories that will make up the final grade by setting it as the external grade.

The weighted totals column will need to be adjusted by going to Edit Column Information and applying weights to assignments or categories created. As setting up the Weighted Total column can be a bit complicated, it is recommended you set an appointment with FCLD to come in for a consultation on setting up your grade center. Make sure you have your syllabus with you when you come to your appointment.

**Step Five: Entering Grades**

To enter grades in Full Grade Center:

- Click into a cell for a graded column.
- Type the grade.
- Click Enter.

Depending on the type of column, e.g., Assignment Tool, Graded Discussion Board, the menu of each cell provides options for viewing work, adding comments, and grading. Click the arrow associated with each cell to use other tools such as View Grade Details, or Grade User Activity, etc.
**Downloading Grades**

To download grades or print a roster in Full Grade Center, point your cursor to **Work Offline** located in the upper right and select **Download**. Fill in information for “. Data” based on what you want to download, leave “2. Options” as set, click **Submit**, and then follow your browser’s cues to download.

![Downloading Grades in Full Grade Center](image)

**General Tips and Tricks**

Feedback is one of the most important tools in teaching and learning. Using Grade Center affords many feedback pathways: grades, anonymous surveys (input from students, results for you!), comments to students, printable reports, email, and benchmarks such as a mid-semester grade.

Here are a few tips and tricks that may help you take full advantage of Blackboard’s Grade Center.

1. A great view of your Grade Center is available from Full Grade Center by clicking **Manage → Column Organization**.
2. Click on the **Student Preview** button so you can see your course from a student’s point of view.
   - Take tests and surveys, do assignments, and monitor how Grade Center performs so you have a good idea of what to expect during the semester.
   - As the Preview User, click **Tools** on the course menu, and select **My Grades**.
   - When done, click the **Exit Preview** button. Make sure you select the second option in the pop-up window that says “Keep the preview user and all data,” then click **Continue**.
3. Make adjustments before the semester begins in order to avoid frantic emails from students, as changes midterm may affect grades negatively and students may comment about it.
4. The Grade Center offers tools for analyzing and reporting on your Grade Center data. For instance, you can set up a couple of short surveys at the beginning and middle of your course, and then use the results to adjust content and delivery if necessary.
5. Hide your final total columns if you do not want students to see Grade Center’s calculations.
6. If your **Total** and **Weighted Total** columns do not seem to be adding up correctly, check the Points Possible you have given to each assignment. We recommend using 100 points as a raw score default, even if you use letter grades.
Creating Digital Content for Online Teaching and Learning

Adding Narration to a PowerPoint

First, you will need to create your PowerPoint presentation and save it. (You can’t record narration until you have saved the presentation first.) To begin adding narration, go to Slide Show → Record Slide Show.

A window will appear, asking you what you want to record. Be sure to check both boxes and select Start Recording.

Your presentation will open in a new window. You can begin your narration, clicking the mouse to advance your slides as you speak.

Important: PowerPoint records the narration as an individual audio file for each slide. Be sure to pause when you have finished narrating a slide and do not begin again until the new slide has appeared, otherwise, you will clip part of your audio.

When you are finished recording your narration, right click and select End Show or use the esc key.

Viewing your Narrated PowerPoint

To view your completed presentation, click on Slide Show and select From Beginning.

The narration will begin and the slides will advance automatically as you view the presentation.

Saving and Distributing your Narrated PowerPoint

It is a good idea to save the narrated PowerPoint as a new file, in case you ever need to go back and edit or change the original PowerPoint. To save the narrated version, go to File → Save As. Be sure to give it a new name so it doesn’t overwrite the original.

Narrated PowerPoints are large, posing problems for students and storage. To get around this, we export the narrated PowerPoint as a video file, then upload it to Ensemble.
To save your presentation as a video, go to **File ➔ Export** and select **Create a Video**. Be patient! Conversion can take a long time...look for the progress bar at the bottom of the PowerPoint screen and wait for it to finish.

Now that it is a movie file, we can upload it to Ensemble or YouTube, then share the link on your Blackboard site. Or upload the movie to your Blackboard course. Keep videos no longer than ten minutes or you will not be able to upload them.

**NOTE: For MAC Users**

There is a known issue saving PowerPoint (2011) as videos for MACs. It creates two files, an audio and an image file, and loses the audio part. Two solutions can be tried to resolve this:

1. Open the PowerPoint presentation in Keynote and export to Quicktime (easiest).
2. Do a screencast of giving your presentation with Ensemble Anthem).

**Uploading to Ensemble (you need a user account first)**

**Logging into your account:**

- Email OTS@hartford.edu to request an Ensemble user account be set up for you.
- Go to [https://ensemble.hartford.edu](https://ensemble.hartford.edu)
- Enter your login information. Your username is the same as your Hartford username (without @hartford.edu) and your password is your University email password. Be sure to set **Identity Provider** dropdown to **Faculty**. Then click the **Login** button.
You are now at the main page of your media library. The main menu buttons for your account are found at the top of the page and along the left side as shown below.

![Media Library in Ensemble](image)

**Uploading a video to your ensemble account**

- If you aren’t there already, click on the **Media Library** button. The Media Library contains all your uploaded videos and is also where you can upload additional videos. Uploaded videos are shown as thumbnails.
- To publish a new video click on the **+Add** button.

![Click the Add Button to add a Video](image)

You will be presented with a series of screens allowing you to provide basic information about the video, including title, date of creation, credits, and more. The first screen is the **Enter Description** page. From this screen, add the video’s title, description, keywords and credits.
The Edit Page

1. Keywords will help you to locate videos in your library and will be useful when you have lots of videos in your library and you need to find one quickly. Be sure to separate Keywords with commas.

   ![Enter Description]

   2. In the Credits section, you have the option of providing information about who made the movie. If you have multiple contributors, you can click the + Add Credit button to add another person.

   ![Enter Credits]

   3. At the bottom of the screen, click Continue to proceed to the Manage Content page.
Manage Content Page

1. Under Options, Audio/Video is selected by default. You can change this to other options.
2. Under Workflow, select the correct video format.
   - Choose ScreenCapture for videos such as narrated PowerPoint presentations or software demonstrations, when clarity of detail outweighs smooth motion.
   - Choose Widescreen for videos that have the extended rectangular shape of a movie screen or widescreen TV (16:9 aspect ratio).
   - Choose Standard for video that has the normal “TV square” shape (4:3 aspect ratio).

   ![Image of Manage Video Page]

   The Manage Video Page

3. Click Add File. Locate the video file you wish to upload and follow the instructions in the upload window OR drag and drop the file from where you have it saved on your computer into the middle of this upload interface where it says “Drag file here.”
4. Click the Start Upload button, then WAIT FOR THE UPLOAD TO FINISH. (See picture below.) If you continue before it finishes, it will fail to upload.

Transforming a Course for Online Learning
5. Auto-Captions will be on by default if you are teaching an online course, flipped or hybrid course. If Auto-Captions are greyed out and you are teaching one of these types of courses, contact OTS@hartford.edu to enable captions for you.

6. Once the progress bar has reached 100%, the screen below will appear down in the Media section. After you upload your file, Ensemble converts the video into a streaming file. As your content moves through the process, Ensemble posts status updates via a series of messages: Waiting for Conversion, Converting…ending with File Ready. The full process may take some time, as there may be several copies. Depending on the bandwidth chosen, Ensemble may prepare many versions suitable to different devices and bandwidths. In this case, it’s OK to advance before the conversions finish. You may now click Continue.
Publishing your Video to Blackboard

- Log into Blackboard.
- Click on Recordings, Course Documents, or another place you wish to put the video. Be sure that Edit Mode is "ON."
- Click Build Content → Ensemble Video.
- It may tell you that you are connecting to an LTI service, click Launch.

Notice that you can also link to a YouTube Video.

Ensemble should pass through your login credentials to Blackboard (if you already have an Ensemble account); however, if it doesn’t recognize you, it may ask you to input your login credentials. Remember: Your username is the same as your Hartford username (without @hartford.edu) and your password is your University email password. Be sure to set Identity Provider dropdown to Faculty. Then click the Submit button.
**Choose Media**

To add one of the videos from the library (as shown above), click the green + sign under the video. Instructors can search their library by typing the name of the video into the search bar or by scrolling through the entire Media Library. You can also choose to preview the video by clicking the black arrow button.

![Click the + to add the video from your Media Library](image)

**Using Ensemble Anthem Screen Capture**

The University of Hartford has a lecture capture platform, Anthem, which is part of our Ensemble streaming media platform. Lecture capture records an instructor’s lecture and then provides students with a link to the recording in Blackboard or via email for later playback. This is often referred to as **Personal Capture** (often referred to as PCAP), and is used to record mini-lectures or demonstrations or to explain difficult concepts so students can review them at home. These recordings can be used to “flip your classroom” – a strategy where students watch short, pre-recorded video “lecturettes” and use the class time for discussion or application of the material.

This guide provides an overview to getting started with **Ensemble Anthem Screen Capture**, including technical requirements, tips and best practices.

Here are the steps for recording a mini-lecture with Ensemble Anthem:

1. Fill out the Ensemble Request form on the FCLD website at: https://www.hartford.edu/faculty-staff/faculty/fcld/blackboard-course-requests-forms/ensemble%20request%20form.aspx.
2. Log into Ensemble and click the **Record** button to download Anthem to your home or office computer.
3. Click the **Record** button again to begin recording mini-lectures using audio, webcam video and screen shots from your computer.
4. Link the recordings to your Blackboard course.
Install Ensemble Anthem (PC)

Before recording for the first time (on any new computer), you will need to download and install the Ensemble Anthem software. This is for individual use only. Please do not install on classroom computers.

If you are a Mac user, please view the Ensemble Anthem for Mac instructions at: http://bit.ly/AnthemMac

1. When you are in Ensemble in any web browser, you will see a record button near the top of the window as shown below. Click on the Record button.

2. A new window will appear asking you if you have installed the Ensemble Anthem Screen Capture application. It should auto detect that you are using a PC, and at the top of the window, click on Download.

3. After the installer file downloads, open the installer file and run through the install process. Once it is complete, the application will be installed on your machine.
**Begin Recording**

There are two ways to record using Ensemble Anthem:

A. You can open the Ensemble Anthem application directly from your computer.
B. When you are logged into Ensemble in any web browser (https://ensemble.hartford.edu), you will see a record button near the top of the window as shown below. Click on the **Record** button.

A message will appear, as shown below. Click on **Open Ensemble Anthem**. To stop this message from appearing in the future, click on the box next to *Always open these types of links in the associated app.*

The Ensemble Anthem application will open and you will see the window shown below.

There are four different options for recording:

**Screen**: Records the screen and from a microphone.

**Screen & Webcam**: Records the screen, the microphone and video from a webcam.

**Webcam**: Records from a webcam and microphone.

**Voice**: Records from a microphone.

If you would like to record your computer screen, click on **Screen**. A new window will appear, asking you to select a screen (if you have multiple monitors), and then asks you to select an area to capture, either the full screen or a specific area of the screen, as shown below.
When you have selected your options and are ready to record, click the **Record** button.

![Record button](image)

**Select the monitor and area to capture, then click Record**

A window will appear along with a countdown letting you know when Anthem will begin recording, as shown below.

![Countdown window](image)

**The countdown to start recording begins**

- To Pause/Resume the recording at any time, press **Alt + P**.
- To Draw on the recording, press **Alt + D**.

While you are recording a screen capture, there will be a menu in the corner of your screen, as shown below. Sometimes, this window will be hidden and you will need to find the **Ensemble** icon located at the bottom of your Windows Toolbar and click on it to open it.

![Ensemble icon](image)

**Locate the Ensemble Icon on your Windows Toolbar**

![Recording window](image)

**Recording is in Progress, use the Tools if needed**
Draw: Click the pencil icon to draw on the screen while you are recording it. This allows you to highlight certain areas.

Pause: This pauses the recording. Click on the pause button again to continue.

Done: This allows you to finish the recording and save it.

Cancel: This will stop the recording and will not save it.

There is also a timer in the window that will tell you how long your screen capture is running.

**Using the Draw Tool while Recording**

You can annotate screen recordings while in progress by clicking on the Draw button in the **Recording Screen Capture** window.

![Draw Tool](image)

Click on the Draw button to annotate your screen recording

When you click on the Draw button, a new menu will appear, as shown below. This menu offers a variety of options for annotating your screen, such as free-hand drawing, adding lines and shapes, etc. Click Done, when finished annotating with the Draw Tool.

![Annotation Options](image)

The Annotation Options under the Draw Tool

When you are finished with your recording, click on the Done button in the Recording Screen capture menu.

![Done Button](image)

Click on the Done button to finish recording your screen
Preview/Edit your Recording and Upload your Video

A new window will now open, the Video Editor, where you will be able to preview your video, as well as trim certain parts of the video, add titles and credits, etc.

The Video Editor Window

Editing your Recording and Uploading your Video

- Click on Titles button and the new screen will allow you to edit the title screen for the beginning of the video.
- Click on the left or right orange arrows to see available templates.
- Once you find which one you’d like, type over the text to create titles.
- Or click on Custom Image to upload your own template from your computer

- Click on the Trim button to trim the beginning and/or the end of the video.
- Slide orange arrows on the top of the screen to adjust the portion to be removed.
• Click on the **Apply** button. The darken part on the timeline of the screen will be deleted from the recording.

• The **Chop** button allows you to remove section in the middle of the video.
  • Slide **orange arrows** on the top of the screen to adjust the portion to be removed.
  • Click on the **Apply** button. The darken part on the timeline of the screen will be deleted from the recording.

• The **Credit** button is the same as the **Titles** button where it adds a slide to finishes the video.
  • When you are done making edits to your video, click on the **Done** button towards the bottom of the video editor window.
• The upload video window will appear, as shown below. Here you can give your video a title and a description, and at the bottom of the window, you can also see the length of the video.
• When you are done making edits to your video, click on the Done button towards the bottom of the video editor window.
• The upload video window will appear, as shown below. Here you can give your video a title and a description, and at the bottom of the window, you can also see the length of the video.
• All videos should be captioned.

Upload: This will save the recording on your computer and upload the recording directly to your media library on Ensemble.

Preview: This will take you back into the video editor window where you can preview the video and make edits.

Save: This will only save your recording to your computer; it will not upload it to your media library in Ensemble.

To upload the video to your media library, click on Upload. You will see a progress bar appear, and when it is done, a confirmation that the upload was completed successfully, as shown below.
Your video will now appear in your Ensemble Media Library, and can be displayed in your Blackboard course, on your website or shared as you like. Other Ensemble documentation can be found on the FCLD website at: https://hartford.edu/fcld.

### Getting Help with Technology at the University of Hartford

**Faculty Center for Learning Development (FCLD)**  
FCLD provides consulting and instructional support to faculty and staff who are using technology in teaching and learning. The FCLD Faculty Lab in Mortensen 203a is available for faculty support and use and is equipped with instructional technology-related equipment including: PCs, Macs, scanners, and projectors as well as support staff. Faculty and Staff needing support with Blackboard or other instructional technologies, should contact FCLD.  
**Phone:** (860) 768-4661  
**Email:** fcld@hartford.edu  
**Website:** [http://www.hartford.edu/fcld](http://www.hartford.edu/fcld)

**Student Blackboard Support**  
The following is student support for Blackboard only. All other support technical support issues need to be addressed to the Office of Technology Services (below).  
**Phone:** (860) 768-4636  
**Email:** bbsupport@hartford.edu  
**FAQ/Submit a Ticket:** [http://www.hartford.edu/studentbbsupport](http://www.hartford.edu/studentbbsupport)

**Information Technology Services (ITS) Help Desk**  
For general computer and Internet/network support questions (not directly related to the classroom but rather passwords, Internet/email problems, Banner/Self-Service, campus Facebook).  
**Phone:** (860) 768-4357  
**Email:** helpdesk@hartford.edu  
**Website:** [http://hartford.edu/ots](http://hartford.edu/ots)

**Media Technology Services (MTS)**  
Faculty should contact MTS for assistance scheduling or implementing classroom technology (2-Way interactive video classrooms, Smart Podiums, laptops, etc.), for setting up WebEx accounts, or for scheduling and instruction for a wide variety of media equipment and resources like LCD data projectors, CD/cassette players, TVs and VCRs, digital video, and more.  
**Phone:** (860) 768-4357  
**Website:** [http://www.hartford.edu/mts](http://www.hartford.edu/mts)